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Notices

This document contains information proprietary to 
FileNET Corporation (FileNET). You may not disclose 
or use any proprietary information or reproduce any 
part of this document without written permission from 
FileNET.

Even though FileNET has tested the hardware and 
software and reviewed the documentation, FileNET 
makes no warranty or representation, either express 
or implied, with respect to the hardware, software, or 
documentation, their quality, performance, merchant-
ability, or fitness for a particular purpose. FileNET has 
made every effort to keep the information in this man-
ual current and accurate as of the date of publication 
or revision. However, FileNET does not guarantee or 
imply that this document is error free or accurate with 
regard to any particular specification. As a result, this 
product is sold as is, and you the purchaser are as-
suming the entire risk as to its quality and perfor-
mance.

In no event will FileNET be liable for direct, indirect, 
special, incidental, or consequential damages result-
ing from any defect in the hardware, software, or doc-
umentation, even if advised of the possibility of such 
damages. In particular, FileNET shall have no liability 
for any programs or data stored in or used with 
FileNET products, including the costs of recovering 
such programs or data.

Some states do not allow the exclusion or limitations 
of liability for incidental or consequential damages, so 
the above limitation or exclusion may not apply to 
your installation. You may also have other rights that 
vary from state to state.

No FileNET agent, dealer, or employee is authorized 
to make any modification, extension, or addition to 
the above statements.
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  About This Manual

This Panagon Fax User’s Guide, publication number 9811095-001, 
supports release 2.0 and subsequent releases of the FileNET Pa-
nagon Fax server software. This manual is written for the system ad-
ministrator who is responsible for the operation and maintenance of the 
fax server.

The fax server connects to the FileNET system through Windows Net-

working software and runs under the Microsoft Windows® NT operat-
ing system, release 4.0. We assume that you have a working 
knowledge of Windows NT and general PC operations. For information 
about the hardware and software requirements for the fax server, see 
the Panagon Fax Installation Guide.

Release Notes
The Release Notes contain important information about Panagon Fax 
that may not be included in this manual, the Panagon Fax Installation 
Guide or the Online Help. The Release Notes display automatically 
during installation through the Windows Write or Notepad application. 



  About This Manual

What to Read First

July 1998 Panagon Fax User’s Guide 8

What to Read First
If you’re a new user to Panagon Fax, we recommend that you begin by 
reading the following chapter in this manual:

Chapter 1, “Overview,” on page 22

Consult the other chapters for complete explanations and detailed ref-
erence material on each application.

Related Publications
Refer to the documentation listed in this section when you install and 
configure the Panagon Fax software.

Hardware Documentation

Refer to the manufacturer-supplied documentation for information on 
your PC, monitor, and peripheral components such as disk drives, con-
trollers, network interface cards, video adapters, and fax interface 
cards.

Windows NT Documentation

For information to install and configure Windows NT, refer to the docu-
mentation provided with your Windows NT software.
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Network Fax Server Documentation

Panagon Fax supports the Optus FACSys Messaging Gateway soft-
ware. In addition to the documents listed, refer to the Optus FACSys 
documentation for installation and configuration information.

• Fax Messaging Gateway for Microsoft Windows NT

• FACSys Release Notes (displayed during FACSys Installation)

FileNET System Documentation

For information on operating and troubleshooting the fax server, refer 
to the following documentation:

Panagon Fax Installation Guide version 2.0

Panagon Fax User’s Guide version 2.0

For information about the Outbound Fax function, refer to the following 
documentation.

Panagon Print Installation Guide version 4.0

Panagon Print Online Help version 4.0

Panagon Print User’s Guide version 4.0

Panagon Fax Installation Guide version 2.0

Panagon Fax Online Help version 2.0

Panagon Fax User’s Guide version 2.0
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For information about the Inbound Fax function, refer to the following 
documentation.

Panagon Fax Installation Guide version 2.0

Panagon Fax Online Help version 2.0

Panagon Fax User’s Guide version 2.0

For information about the WorkForce Desktop application, refer to the 
following documentation.

• WorkForce Desktop Coordinator’s Handbook

• WorkForce Desktop User’s Guide

For information about the IDM Image Services (IDMIS), refer to the fol-
lowing documentation.

• System Administrator’s Handbook

• System Administrator’s Companion (IDMIS Release 3.4.x and 
later)
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FileNET Programming Documentation

For information on FileNET’s WorkFlo programming language, refer to 
the following documentation: 

• WorkFlo Script Developer’s Guide, Volumes I and II

• WorkFlo Script Quick Reference Guide

• WorkFlo Controls for Visual Basic Reference

• WorkFlo Controls for Visual Basic Programmer’s Guide
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New Features or Changes in This Release
Panagon Fax 2.0 is designed to replace the WorkFlo/Fax product. The 
goal is to enable the user to use the Panagon Fax server PC as a fully-
operational fax server without additional user intervention.

Panagon Fax 2.0 contains the same features as WorkFlo/Fax 3.0.3. 
The major focus of Panagon Fax 2.0 includes:

• New packaging for Panagon Fax 2.0, which includes a custom In-
bound Fax Visual Basic application replacement. 

• Using the Panagon Capture BES (Batch Entry Services) Reposi-
tory to enter faxes into the IDMIS. (WorkFlo/Fax used the WorkFlo/
Scan Image Import application.)

• Synchronization of common files with the IDM Desktop 2.0 release.

The following list summarizes new features in the Panagon Fax release 
2.0. For more information, refer to the corresponding section indicated 
after each description.
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General Panagon Fax Support

New Terminology Defining 2.0 Panagon Fax

The 2.0 Panagon Fax package includes: 

• Panagon Capture Fax, the Inbound Fax package, contains the fol-
lowing:

A custom Panagon Fax Entry Visual Basic application 

The Panagon Capture Fax Component

• Fax Manager, Outbound Fax, uses Panagon Print 4.0.

For information to install and configure these packages, refer to the Pa-
nagon Fax Installation Guide. 

New 2.0 Panagon Fax Packaging

Panagon Fax is packaged and distributed on Compact Disks. Inbound 
Fax and Outbound Fax is packaged as follows:

Inbound Fax: Panagon Capture 2.0 Master CD
(Includes a key to install the Capture application, the 
Fax component, and the DocEntry component.) 

Outbound Fax: Panagon Print 4.0 CD
Optus FACSys Fax Messaging Gateway
(Includes10 client licenses. Is currently distributed 
on diskette, but scheduled for CD-Rom distribution.)
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Inbound Panagon Fax Support

Custom Visual Basic Panagon Fax Entry Program

Fax Entry now functions through a custom Visual Basic application, us-
ing the Panagon Capture Fax OCX (Active X) control. The new applica-
tion retains a user interface similar to the WorkFlo/Fax product, while 
incorporating the power and consistency of the Panagon Capture 
Component technology.

For information to install and configure Panagon Inbound Fax, refer to 
the chapters “Install the Panagon Capture Software” and “Configuring 
Panagon Fax Entry” in the Panagon Fax Installation Guide.

New System Configuration Option

This feature enables the user to check the option Display Important 
Messages in Popup Boxes. If checked, this option displays important 
messages from the Activity Trace Window. A user response is required 
to continue processing. For information to configure this option, refer to 
“Display Important Messages” on page 117. 

New Inbound Migration and File Migration Configuration Options

The following parameters are included on the Inbound Migration and 
File Migration dialog boxes and perform as follows:

Backup Directory Allows user to select drive if Panagon Fax Entry 
is configured to back up files/faxes to a local or 
network drive.

Cache Directory Specifies temporary storage location for In-
bound faxes.



  About This Manual

New Features or Changes in This Release

July 1998 Panagon Fax User’s Guide 15

Error Directory Indicates the directory to contain failed inbound 
faxes.

Batch Prefix Specifies the prefix that Panagon Fax Entry as-
signs to each batch before it is processed.

Batch Folder Selects the repository folder in which Inbound 
batches are created and stored.

Batch Disposition Specifies the final state of batches created dur-
ing processing with one of the following three 
options: Leave Batch Unindexed, Index Batch 
but Leave Uncommitted, or Index Batch and 
Commit.

DocProcessing Executes DocProcessing before the Event Acti-
vator or after Assembly, as the user selects, if 
the Panagon Capture DocProcessing package 
was purchased.

For additional information, refer to the chapters “Configuring Inbound 
Migration Parameters” and “Configuring File Migration Parameters” in 
the Panagon Fax Installation Guide. 

For details, refer to the Online Help. 
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These parameters are also included on the Inbound Migration and File 
Migration Configuration dialog boxes and perform the following func-
tions:

Batch Template Indicates the Panagon Template that will be 
used during processing. The Template is cre-
ated using the Panagon Capture application.

Batch Settings Specifies the Panagon Settings collection that 
will be used during processing. The Settings col-
lection are created using the Panagon Capture 
application.

For detailed information, refer to the chapters “Configuring Inbound Mi-
gration Parameters” and “Configuring File Migration Parameters” in the 
Panagon Fax Installation Guide. For definition information, refer to the 
Online Help.

To create Templates and Settings, refer to “Settings and Templates” in 
the Panagon Fax Installation Guide.

New Journal Migration Configuration Options

The following parameters are included on the Journal Migration dialog 
box and perform as follows:

Backup Directory Allows user to select drive if Panagon Fax Entry 
is configured to back up files/faxes to a local or 
network drive.

Batch Prefix Specifies the prefix that Panagon Fax Entry as-
signs to each batch before it is processed.



  About This Manual

New Features or Changes in This Release

July 1998 Panagon Fax User’s Guide 17

Batch Folder Selects the repository folder in which Inbound 
batches are created and stored.

Batch Disposition Specifies the final state of batches created dur-
ing processing with one of the following three 
options: Leave Batch Unindexed, Index Batch 
but Leave Uncommitted, or Index Batch and 
Commit.

For additional information, refer to the chapter “Configuring Journal Mi-
gration Parameters” in the Panagon Fax Installation Guide. For details, 
refer to the Online Help. 

The additional parameters are also included on the Journal Migration 
Configuration dialog boxes and perform the following functions:

Batch Template Indicates the Panagon Template that will be 
used during processing. The Template is cre-
ated using the Panagon Capture application.

Batch Settings Specifies the Panagon Settings collection that 
will be used during processing. The Settings col-
lection are created using the Panagon Capture 
application.

For detailed information, refer to the chapter “Configuring Journal Mi-
gration Parameters”  in the Panagon Fax Installation Guide. For details, 
refer to the Online Help.

To create Templates and Settings, refer to the chapter “Settings and 
Templates” in the Panagon Fax Installation Guide. 
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Outbound Panagon Fax Support

The Fax Manager Performs Outbound Functions Only

All Inbound properties, functionality, and monitoring has been removed 
from the Fax Manager and placed in Panagon Capture Fax (Inbound 
Fax) and Fax Entry programs. The Fax Manager interface and func-
tionality is similar to the WorkFlo/Fax product. 

For more information on Outbound Fax, refer to the chapters “Installing 
and Configuring Panagon Print Software for Outbound Fax” and “Con-
figuring the Panagon Fax Manager” in the Panagon Fax Installation 
Guide. 
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Tips, Notes & CAUTIONs
Throughout this manual, you will see messages designed to display 
important information:

Tip Indicates hints to make your work easier.

Note Points to important information, such as situations that can affect the 
outcome of an operation or affect some other part of the system.

CAUTION Signals possible loss of data or time.

Screen Prompts and Messages

Text that displays on the screen looks like this in the manual:

Keyboard Commands

Commands you are to type on a keyboard appear in bold typeface, as 
shown in the following example.

cd \winnt\system

Final step.

Now transferring all other log files to a new 

tape.
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Education
FileNET offers introductory and advanced classes for system adminis-
trators, developers, management, and support personnel. These 
classes combine lecture and lab sessions to provide both conceptual 
understanding of the FileNET system and practice in its operation. For 
more information on class content and schedules, please visit the Edu-
cation topics in the Services and Support area of FileNET's web site

http://www.filenet.com

You can also use the following telephone numbers to request informa-
tion and to ask questions:

Local714.966.3412
Toll Free888.FNEDUC8  (888.363.3828)

http://www.filenet.com
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 Comments & Suggestions
FileNET invites all customers to communicate with the Documentation 
group on any question or comment related to FileNET manuals and 
online help. Fax, phone, mail, or email any question or comment to 
Mike Calvert at one of the numbers or addresses listed below. We 
guarantee a response to each communication within one week. Your 
suggestions help us improve the products we deliver.

Mike Calvert
Director of Documentation
FileNET Corporation
3565 Harbor Boulevard
Costa Mesa, California  92626-1420

Phone:714.966.3449
Fax:714.966.7153
Email:calvert@filenet.con
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1
1Overview

Panagon Fax consists of a number of software components that inter-
act with each other. These components make up the Panagon Fax sys-
tem and are used to:

• Receive inbound FileNET images and migrate them to a FileNET 
IDMIS along with their indexing data.

• Transmit FileNET images retrieved from the IDMIS to a remote fax 
machine or fax server.

• Send or receive supported non-FileNET fax documents.

• Create journal logs that can be migrated to an IDMIS or backed up 
to a local or network drive.

The purpose of this chapter is to provide you with an overview of the 
functionality of these components. Understanding the function of these 
components within Panagon Fax will make managing inbound and out-
bound faxes easier. 

For a more complete description of these components, including the 
system requirements needed to run them, refer to the Panagon Fax In-
stallation Guide. 
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Fax Terminology
Some terms in the Fax process warrant additional definition as used. 
Such terms are defined in the following sections.

Images and Documents

An inbound fax creates an image, just as a scanned page is an image. 
A document consists of one or more images. Images must be com-
bined to form documents.  This is called Assembly.

Initially, the FileNET system assigns a unique identification number 
called an image ID to each image or page. For example, the image IDs 
of a two-page document may be: 1294966183, 1294966184. The im-
age ID is later used to determine the permanent document ID for the 
entire document after the document is committed. 

Before committing a document, the system assigns a document se-
quence ID to each document within a batch, indicating the document’s 
position in the batch. For example, Document Sequence IDs 1, 2, and 
3 refer to the first, second, and third documents within one batch.

Later, when the document is committed to optical disk, FileNET as-
signs a unique document ID to the entire document, based on the im-
age ID. For single-image documents, the image ID becomes the 
document id. For multi-image documents, the image ID of the first im-
age in the document becomes the document ID for the entire docu-
ment. For example, the document ID derived from the previous image 
ID example would be 1294966183. You can use a document ID in a 
query to locate the document.
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Committal

Committal is the process of storing images and their index values. 
Writing index information to the database is called cataloging. Writing 
documents to optical disk is called migration. When you commit a 
batch, documents move from the Batch Entry Service (BES) cache on 
the IDMIS server to optical disk. Or, you can also commit a batch with-
out migrating it to optical disk. Committal and migration options are dis-
cussed in detail in the WorkForce Desktop User’s Guide.

Document Class

Document classes are profiles stored on IDMIS servers that provide a 
template for entering keywords while indexing a batch of documents. 
Document classes also provide information on read, write, and ap-
pend/execute security privileges. Once a document is committed to 
storage media, operators retrieve it by entering its document ID or in-
dexing keywords.

The system administrator creates a document class for each document 
type using the Database Maintenance application in the IDMIS. The 
document class is assigned when a template is created and used for a 
specific batch. Batches cannot be created without a document class 
and template.

When you set up a document class in Database Maintenance, you de-
termine certain defaults for all documents in that class, such as media 
family name, whether to verify images, who can access the docu-
ments, and which indexes to use. Care in designing document classes 
is worthwhile as document classes cannot be deleted.

The components that are part of Panagon Capture use these docu-
ment class settings as default values. However, if a Panagon Capture 
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component has a different value than that defined in the document 
class, the value in the component takes precedence and is used for 
batch processing. 

BES repositories have full access to all document classes defined on 
the IDMIS server. However, ODBC repositories (local repositories) 
cannot access document class information on BES. If you create a 
batch on an ODBC repository, you must manually enter the name of 
the document class the batch will use after it transfers to the BES for 
indexing and committal.

Repositories

A repository is a database in which incoming files are stored. Panagon 
Capture supports two repository types: a BES (Batch Entry Services) 
repository (remote) and an ODBC (open database connectivity) local 
repository. BES repositories reside on FileNET IDMIS servers. ODBC 
repositories can be on the local drive or on a different server or work-
station on the network. 

When you create your settings collection and template in Panagon 
Capture for Fax, you must specify the repository in which your Settings 
collection and Template will be stored. The local ODBC repository is 
very similar to the BES repository with one major exception -- the local 
ODBC repository cannot access information about document classes. 
If a batch contains no document class information, the batch cannot be 
indexed or committed. Therefore, when you specify the repository in 
which your settings collection and template are to be stored, be sure to 
indicate the BES repository; you cannot index or commit if you select 
the ODBC local repository until you move the batch to the IDMIS re-
pository.
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Note If you selected an ODBC repository and set the Batch Disposition op-
tion in any configuration dialog boxes to Index Batch but Leave Un-
Committed or Index Batch and Commit, Fax Entry will return errors 
when trying to index or commit the batch.

When configuring Panagon Fax, if you select either of these Migration 
Options: Commit To IMS or Backup and Commit, faxes/files are com-
mitted to the IDMIS and moved to BES Repository for storage. For de-
tailed information on BES repositories, refer to the IDMIS System 
Administrator’s Handbook, “Cache Organization” section. BES reposi-
tory is referred to as batch cache on the IDMIS.

Repository Structure

Repositories have a flexible hierarchical structure. The repository hier-
archy can have as many folder levels as you wish. This allows you to 
structure the repositories to reflect the way you work.

Folders and Batches

Within a repository you can create folders and batches.

A folder is an object within a repository that works much like a paper 
folder. Folders can contain other folders or batches of documents. 
Folders are optional.

A batch is a set of similar documents that are processed through the 
document capture and document entry functions as a group. All docu-
ments in a batch must belong to the same document class and have 
the same indexing requirements. Batches are committed to the IDMIS 
as a group. After committal, the name assigned to the batch is dis-
carded, since documents are individually retrieved through their docu-
ment ID or indexing keywords. 
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Batches are required in the repository hierarchy. A file or fax must al-
ways be contained within a batch to be processed. Therefore, a repos-
itory must always contain batches.

When configuring Fax in the Inbound Migration Configuration, File Mi-
gration Configuration, and Journal Migration Configuration dialog 
boxes, you can specify the following about batches: Batch Prefix, 
Batch Folder, Batch Template, Batch Settings, and Batch Disposition.

 Components

Panagon Capture consists of processing steps that are separate Ac-
tive X (OCX) controls rather than pieces of an individual application. 
For example, scanning, assembly, image verification and indexing are 
separate controls rather than being parts of a monolithic scan applica-
tion. These OCX controls are called components. 

Settings Collections

When you create a settings collection, you specify the document class 
that is assigned to the settings collection. The document class defines 
the indexing requirements used when the batch is committed to stor-
age media; each batch has an assigned document class. Therefore, 
when the operator uses a settings collection, the document class is se-
lected automatically. 

Settings collections are stored in repositories. By default, they are 
stored in a subfolder of the Config folder named Settings. You can 
change the path of the repository containing the settings collections 
through the Control Properties dialog box.
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Templates

Templates are stored with capture paths and settings collections in the 
CONFIG directory of a repository. The CONFIG directory path is set in 
the Control Properties dialog box. Templates contain information about 
the settings collection and, if your workflow is automated, the template 
also contains the name of the capture path. 
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Panagon Fax Components
Panagon Fax release 2.0 consists of a number of software compo-
nents that interact with each other to:

• Receive inbound FileNET faxes or files and either move them to 
the Panagon Capture Repository for further processing, or commit 
them directly to a FileNET IDMIS.

• Transmit FileNET documents retrieved from the IDMIS to an exter-
nal Fax destination. 

• Send or receive supported non-FileNET faxes or files.

• Create journal logs that can be committed to an IDMIS and moved 
to a Local or BES Repository, or backed up to a local or network 
drive.

You must install and configure these components separately. Refer to 
the Panagon Fax Installation Guide for installation and configuration. 
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Panagon Fax includes the following components:

• Network Fax Server Gateway software

• Inbound Fax: Panagon Capture Fax Component, containing the fol-
lowing:

A custom Panagon Fax Entry Visual Basic application 

The Panagon Capture Fax Component

Panagon Capture Application

• Outbound Fax: Panagon Print 4.0 (Panagon Fax edition), contain-
ing the Fax Manager application.

The following sections describe each of these components, their role in 
inbound and outbound fax operations, and the process that occurs with 
these components in the Panagon Fax software.
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Network Fax Server Software

The Network Fax Gateway Server software is third-party software 
product that runs on a PC under Windows NT. Release 2.0 supports 
only the Optus FACSys Messaging Gateway as a Network Fax Server. 
The Network Fax Server software receives inbound images and trans-
mits outbound FileNET IDMIS documents to and from Group 3/4 fax 
machines. 

Ten FACSys client licenses and media are included and can be used to 
send and receive non-FileNET fax documents, if desired. The client 
software that is available as part of the Network Fax Server package 
provides fax functions such as phone book management, cover page 
generation, send function, and received fax viewer. 

The FACSys client software is also used to administer the FACSys 
server from a remote station over the LAN.

The Panagon Fax outbound fax process functions as follows:

• A Fax request is sent from an IDM or equivalent workstation.

• IDMIS receives the fax request and queues it to Print Services.

• Panagon Fax services the Fax requests that are queued to Print 
Services.

• Panagon Fax sends the requests to the FACSys Gateway in Post-
Script Level II format.

• The FACSys Gateway faxes the PostScript objects to the remote 
fax destination.
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The following illustrates the Panagon Fax Outbound Fax Process.

IDMIS Server

Panagon Fax Server with
Windows NT and
Network Fax Server software

Fax Machine

IDM Desktop
Fax is sent from an
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16 Fax Channels

The Network Fax Server supports up to four fax boards. Each board 
supports up to four fax ports, providing a total of 16 fax channels per 
server. Each channel can be configured for inbound traffic, outbound 
traffic, or bi-directional (inbound/outbound) traffic. 

Twenty-four-line T1 configurations are also supported.

Network Fax Server

Channel 1

Channel 2

Channel 3

Channel 4

Channel 5

Channel 6

Channel 7

Channel 8

Fax Card 1

Port 1

Port 2

Port 3

Port 4

Fax Card 2

Port 1

Port 2

Port 3

Port 4
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Inbound Routing Process

The Network Fax Server performs the following functions in the routing 
process:

• Examines the header of the incoming fax for routing data.

• Searches for one of the described routing elements in the order 
previously listed in the Routing Options table.

• Routes an incoming fax to a specific document class or uses the in-
formation for automatic indexing. 

Note Fax attributes, such as DID, DTMF, ANI, CSID, Date and Time are 
available as Capture attributes. Capture programs use these Fax at-
tributes to index and route faxes to document classes.

Tip You can view Fax attributes by right clicking the faxed pages within a 
batch in the BES Repository.
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Routing Options

All inbound faxes come into one default document class. Based on the 
Routing Option associated with the fax, it is routed to the appropriate 
document class and/or the information can be used for automatic in-
dexing. The Routing Options are outlined in the following table. 

Routing Option Description

DID If the customer’s telephone service supports Direct 
Inward Dial (DID), the Network Fax Server can use 
from 1 to 15 digits of the called phone number to as-
sign the DID data to a specific document class and/or 
use the information for automatic indexing. 

DTMF If the customer’s telephone service supports Dual 
Tone Multiple Frequency (DTMF), the fax sender can 
enter a configurable number of digits at the fax ma-
chine -- usually a four-digit extension. The Network 
Fax Server will use the DTMF data to assign the fax 
to a specific document class and/or can save the 
DTMF data for automatic indexing information. 

CSID The Network Fax Server can assign an inbound fax 
to a specific document class and/or use the Call Sub-
scriber ID (CSID) for automatic indexing. The Call 
Subscriber ID is the fax header field from the sending 
fax machine.
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Routing Option Description

Caller ID (or ANI) Caller ID (ANI) functionality will be officially qualified 
at a later date. Until it is officially qualified, Caller ID 
will be classified as a configurable feature and will not 
be supported. Refer to the following location on 
FileNET’s Web site for official qualification support 
notification:

http://www.css.filenet.com/documentation/
index.html

Panagon Fax uses Caller ID to capture the telephone 
number of the sending fax machine. The sending fax 
number can be used as indexing information and will 
assign the inbound fax to the appropriate Document 
Class.

Line (Channel) 
Routing

You can configure the Network Fax Server software 
to assign all faxes coming in on a specific fax card 
port (such as port 3) to a specific user/document 
class on the IDMIS.

Manual Routing 
by the Network 
Fax Server 
Administrator

If none of the elements previously described deter-
mines the inbound fax’s destination, the fax is as-
signed to the Network Fax Server administrator, who 
can forward the fax to its correct document class.

Non-IDMIS Routing The FACSys Gateway can receive faxes that will not 
be stored on the IDMIS. Non-IDMIS users can be 
configured on the FACSys Gateway software. Ten 
users are included with each Panagon Fax license 
and one or more must be configured as an IDMIS 
destination. 

http://www.css.filenet.com/documentation/index.html
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DID Overview

If the customer’s telephone service supports DID (Direct Inward Dial), 
the Network Fax Server can use from 1 to 15 digits of the called phone 
number to route a fax to a specific document class. DID can also be 
used for indexing information.

DID, in general, is a method to use a special DID telephone line from 
the telephone company to route incoming calls to one of several tele-
phone numbers. This single telephone line can have many telephone 
numbers assigned to it. When callers dial one of these telephone num-
bers, the DID device attached to that DID line detects which number 
was dialed.

To configure DID, refer to the Panagon Fax Installation Guide. 

DTMF Overview

If the customer’s telephone service supports DTMF, the fax sender can 
enter a configurable number of digits at the fax machine -- usually a 
four-digit extension. The Network Fax Server will use the DTMF data to 
route the fax to a specific document class or can save the DTMF data 
for automatic indexing information.

To configure DTMF, refer to the Panagon Fax Installation Guide. 
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In the following illustration, inbound faxes are routed to a specific docu-
ment class, based on the channel number of the inbound fax. For ex-
ample, Inbound Fax #1 routes the fax to DocClass2 because the 
channel number (channel 2) in the inbound fax header maps to that 
document class in the Network Fax Server software.

You can choose to route faxes to a document class or use the informa-
tion for automatic indexing, based on the routing options discussed 
previously, as long as the Network Fax Server software is configured to 
support the routing option.

Inbound Fax #1

Inbound Fax #2

Inbound Fax #3

Panagon Fax Server

Channel 1

Channel 2

Channel 3

Channel 4

Channel 5

Channel 6

Channel 7

Channel 8

Fax Card 1

Fax Card 2

Fax Server Software
User List

Channel 2 = DocClass2
Channel 4 = DocClass4
Channel 6 = DocClass6

Fax Manager

Document Class 
= 

DocClass2

Inbound Fax #1
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Panagon Fax Server Software

The Panagon Fax Server software consists of the following compo-
nents:

• Panagon Capture Fax, the Inbound Fax package, contains the fol-
lowing:

A custom Panagon Fax Entry Visual Basic application to route 
faxes from the Network Fax server to Panagon Capture.

The Panagon Capture Fax Component

The Panagon Document Entry Components

• Fax Manager, Outbound Fax, uses Panagon Print 4.0 (Fax edition).

You must install the Panagon Fax Server software and the Network 
Fax Server software (Optus FACSys) on the same computer.

Note Do not install the Panagon Fax Server software components on a Win-
dows NT machine on which you have installed IDMIS server software.

Each component performs a specific task for the inbound or outbound 
fax operations. The sections that follow describe the processing that 
occurs and the role of each software component for inbound and out-
bound fax operations.



1  Overview

Panagon Fax Components

July 1998 Panagon Fax User’s Guide 40

Outbound Fax

The outbound fax operation uses Panagon Print and the Fax Manager.

When you want to send an image to a remote destination through fax, 
use either the WorkForce Desktop Image Display (FileNET print op-
tion) or the Panagon IDM Desktop (FileNET print option) to submit the 
fax request to the IDMIS. The IDMIS server forwards the image(s) to 
the Panagon Fax server. 

Retrieved image forwarded
to Panagon Fax Server

Panagon Fax Server

Work Station

User initiates a request
to print an image from
the IDMIS or Image Display.
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Panagon Print

The Panagon Print software on the Panagon Fax server performs the 
following functions in the outbound fax process:

• Accepts the print request from the IDMIS server

• Translates the images from their original FileNET format into Post-
Script Level II format

• Passes them to the Network Fax server for transmission to a re-
mote destination

Panagon Fax

Optus FACSys

Interfax

Translation

Layer

Fax Manager

Panagon Print

Translates Image to PS Level 2

Image from IDMIS

Telco
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Once Panagon Print passes an image to the Network Fax Server, if the 
True Status feature is enabled, it polls the Network Fax Server’s fax 
queue to check the status of the outbound fax. When the fax status in 
the Network Fax Server’s queue changes to “Complete” (which in-
cludes both successful and failed states), Print relays this information 
to the IMS server from which the image originated, then updates the 
entry in the Network Fax Server’s fax queue to “IMS Notified”.

Complete

Panagon Print passes image
to Network Fax Server

Panagon Print polls the

for fax status

Send “Status Complete”
message to IDMIS Server

Update Network Fax Server
queue to “IDMIS Notified”

Yes

No
Status =

Network Fax Server queue
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The Panagon Fax Manager works with Panagon Print to manage the 
Network Fax Server send queue for outbound faxes. It checks the Net-
work Fax Server send queue for entries with a status of “Completed”.

When it finds such an entry, the Fax Manager creates an entry in its 
own System Journal Log, then deletes the entry from the Network Fax 
Server send queue.  

If the Fax Manager finds a “Completed” item with a “failed” status in the 
send queue, the Fax Manager leaves this item in the send queue. The 
fax can then be retried, or manually printed or faxed.

For information on failed faxes, see “Retrying Failed Faxes” on 
page 69.
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Yes

No

Fax Manager checks Network
Fax Server queue for entries

marked “Completed”

Entry
Found

Makes an entry in
the System Journal Log

If successful, deletes
entry from the Net-
work Fax Server 
send queue.

If failed, leaves entry
in the outbound folder
or deletes entry from
Optus queue, as 
specified by the 
checkbox in the Re-
quest Migration tab. 
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Inbound Fax

The Inbound Fax software accepts faxes from a remote location 
through the Optus FACSys Fax Gateway. Inbound Fax then either com-
mits the images to the IDMIS or moves them to a Local or BES Repos-
itory if additional indexing is required. Fax batches created in the 
Capture BES Repository can be indexed and processed with all Pa-
nagon Capture indexing and DocProcessing components.

The Panagon Capture Fax Component checks the Network Fax Server 
queue at a configurable interval to see if inbound faxes destined for 
Capture or IDMIS have arrived.

For information on how the Network Fax Server routes inbound faxes 
to Panagon Fax, refer to the section “Routing Options” on page 35. 
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Journal Logs and Activity Trace

The Fax Manager and Fax Entry both maintain journal logs. The Fax 
Manager can be configured to migrate its journal entry log to an ASCII 
text file. Configuring the Fax Manager in this manner allows users to 
create logs of specific activity types, such as inbound or outbound fax 
requests. Both Fax Entry and the Fax Manager can have their respec-
tive journal log files migrated to the IDMIS for storage, if desired. Logs 
and files can also be backed up to disk.

The Fax Manager can show different views of the same journal file 
based on the filtering criteria specified by the user. For example, in one 
view, the user may want to see only successful entries; while in an-
other view, the user may want to see only failed entries.

As an aid to troubleshooting, activate an optional activity trace function 
within the Fax Manager and Fax Entry. Activity trace files can be mi-
grated to the IDMIS through the Fax Entry or backed up to disk for later 
review and analysis.
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2
2Managing Outbound Documents

This chapter describes how to initiate the Panagon Fax software and 
the applications contained in the FileNET Panagon Server Applications 
program group. These applications are used to manage outbound doc-
uments. Refer to the WorkForce Desktop User’s Guide for supplemen-
tary information.

Starting Panagon Fax Software
Panagon Fax Manager works with other Panagon Fax software compo-
nents to send FileNET images through a local or remote Network Fax 
Server. When configured correctly for your environment, Panagon Fax 
Manager performs its functions automatically without user intervention.

Panagon Fax uses icons in two program groups. The FileNET Pa-
nagon Fax Entry icon, located in the FileNET Panagon Capture pro-
gram group, initiates inbound fax. The Panagon Fax Manager icon, 
located in the FileNET Panagon Server Applications program group, 
initiates outbound fax. Both program group icons are located in the 
Windows NT Program Manager. 

When you install Panagon Fax software, you can choose to have the 
FileNET Panagon Fax Entry icon, the Panagon Fax Manager icon and 
Panagon Print Administrator icon automatically copied to the Startup 
group on your Windows desktop. This allows remote stations to trans-
mit and/or receive faxes when the Windows NT server boots.
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Double click on the FileNET Panagon Server Applications program 
group.

The FileNET Panagon Server Applications program group contains the   
applications that you will use to manage outbound fax documents. 

For Outbound Fax

For Inbound Fax
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The following table describes the function of these icons and lists a 
page number where you can find more information.

Icon Description See

Provides banners, a journal, and an activity 
trace for monitoring outbound, successful, 
and failed fax transmissions.

page 
51

Monitors fax activity between the server 
and printer and between the IDMIS and 
print server. It also displays the fax error log 
and statistics.

page 
71

Panagon Fax
Manager

Panagon Print
Administrator
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Displays and changes Panagon Print con-
figuration parameters.

page 
87

Upgrades to newer versions of the Pa-
nagon Fax Print edition.

page 
89

Panagon Print
Configuration

Panagon Print
Setup
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Panagon Fax Manager
Use the Panagon Fax Manager application to:

• Monitor outbound fax activity.

• View outbound, successful, and failed fax transmissions. Failed fax 
transmissions include failed faxes that will be retried and those that 
will be deleted and not retried. 

• View condensed, normal, or detailed journal information.

• View and change Panagon Fax Manager configuration parameters.

• Trace Panagon Fax Manager activities.

Accessing the Panagon Fax Manager Window

The Panagon Fax Manager icon is located in the FileNET Panagon 
Server Applications program group.

To access the Panagon Fax Manager, double-click on the following 
icon:

The following window displays.

Panagon Fax
Manager
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Understanding the Panagon Fax Manager Window

The following window shows the Panagon Fax Manager window com-
ponents. In this case, the right half of the FAXJRN.DAT journal window 
is displayed in Detailed view.
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Note When the Panagon Fax Manager window displays, the FAXJRN.DAT 
journal window also displays, but the Activity Trace window does not. 
To display the Activity Trace window, select Activity Trace in the Tools 
menu.

Toolbar

FAXJRN.DAT 

Status Bar

Journal Window Log

Menu bar

Faxes Transmitted Ribbon

Activity Trace Window
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Menu Bar

The menu bar contains commands to perform various Panagon Fax 
Manager tasks. Some menus and commands are always available, 
while others are available only when the FAXJRN.DAT journal window 
or Activity Trace window is active. 

The following table describes each pull-down menu in the Menu Bar 
(as illustrated in the File pull-down). 

See “Switching Between Windows” on page 67 for information on how 
to make a window active.

Menu Command Description

File Save As Saves an open file in a new directory or un-
der a new name.

Print Prints a file.

Print Preview Shows how the printed journal will appear 
before you print it.

Print Setup Selects print parameters.

Exit Exits the Panagon Fax Manager window.
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View Toolbar Displays or hides the toolbar. 

Status Bar Displays or hides the status bar. 

Outbound Displays outbound faxes in the journal win-
dow.

Successful Displays successfully sent faxes in the jour-
nal window.

Failed Displays unsuccessfully sent faxes in the 
journal window.

Condensed Displays minimal information about each fax 
transaction.

Normal Provides basic information about each fax 
transaction.

Detailed Provides maximum information about each 
fax transaction.

Tools Activity Trace Displays or hides the Activity Trace window.

Configuration Displays and changes Panagon Fax Man-
ager configuration parameters.

Window Arranges the windows on your desktop.

Help Displays online help.
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Toolbar

The Toolbar appears below the menu bar. The toolbar provides a fast 
way to perform tasks. The following illustration describes the tools in 
the toolbar.

All these tools are available when the FAXJRN.DAT journal window is 
active. The four tools on the right affect which entries will display in the 
journal window.

Tip To see the function of a tool, place your mouse pointer over the tool. 
Tool tips automatically appear at the pointer location, explaining the 
function of the tool.

You can toggle the tool bar on or off by using the Tool Bar command in 
the View menu.

Save a File

Print a File

 

View 

Faxes

View 
Failed
Faxes

View 

Faxes

Display 
Fax Manager
Version

Outbound 

Successful
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Faxes Transmitted Ribbon

The   Faxes Transmitted ribbon is below the toolbar and shows: 

• The total number of outbound fax requests the Network Fax Server 
queue processed.

• The number of outbound requests completed successfully.

• The number of outbound requests that failed.

The number of successful and failed outbound requests equals the to-
tal number of outbound fax requests passed to the Network Fax Server 
queue. The following illustration shows a typical outbound migration 
ribbon.
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FAXJRN.DAT Journal 

Note If the Migrate Failed Outbound Fax checkbox is not checked in the Re-
quest Migration tab of the Panagon Fax Manager Configuration, failed 
faxes will not  be logged in the Journal.

The Panagon Fax Manager window automatically displays the 
FAXJRN.DAT journal. The FAXJRN.DAT journal contains columns that 
show the fax activity status by reflecting the contents of the 
FAXJRN.DAT file. The FAXJRN.DAT file resides in the c:\fnsw_loc\tmp 
directory. 

You can automatically save journal entries from the Journal Log file 
FAXJRN.DAT to a customizable journal file on the Panagon Fax 
server’s disk by enabling Journal AutoSave in the Panagon Fax Man-
ager configuration. This journal file can be committed to the IDMIS and 
moved to Local or BES cache without being backed up, or backed up 
to a local or network drive, or both.

The name of the journal file is system-assigned. The file name format 
is: 

JRNmmddA.yyy

where

mmdd represents the month and date that the journal file was cre-
ated

A is a fixed character with no significance

yyy is the sequence number
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Each line in the journal window is a fax transaction, with recent trans-
actions appearing at the bottom of the window. The maximum number 
of entries that can be displayed in the journal window defaults to 500. 
The contents in the FAXJRN.DAT journal are updated according to the 
AutoSave Interval value you entered during Panagon Fax configuration 
(refer to the Panagon Fax Manager online help).

Additionally you can save current data from the journal window by se-
lecting the Save button from the toolbar or the SaveAs in the File 
Menu. The data will be saved with the file extension .TXT to indicate 
that it is an ASCII file. You can use a different extension by deleting the 
.TXT extension and replacing it with any three-character extension. 
The file is saved in the fnsw_loc\tmp directory by default. 

Viewing Information in the Journal Window

You can use the toolbar or the commands in the View menu to control 
the amount of information shown in the journal window, such as:

Toolbar Provides tools for viewing all fax transac-
tions, or toggles outbound, successful, or 
failed transactions on and off.

View menu commands Provides commands for performing toolbar 
functions and for viewing condensed, nor-
mal, and detailed information in the journal 
window. The following table describes the 
fields that display for each view.

Tip To change the journal window view quickly, place the pointer in the 
journal window, click the right mouse button to display a popup menu, 
and select a command.
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View Fields Description

Condensed Type Shows whether a fax has been transmitted 
(SEND).

Time The date and time, in 24-hour format, when a 
fax was sent.

Pages The number of pages sent.

Phone The telephone number of the remote fax desti-
nation.

Status Shows if a transaction was successful (OK), 
cancelled (ABORT), or resulted in an error 
(ERR).

Job ID The outbound fax Job ID number is assigned by 
Print Services.

Error Shows the cause of an error, if a transmission 
cannot be completed. See “Viewing Errors in the 
Journal Window” on page 64.
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Normal Shows the Condensed information and adds:

Recipient Specifies the name of the sender for an out-
bound fax.

Channel The Panagon Fax Server port through which 
the fax was sent.

Detailed Shows Condensed view and Normal view, and adds:

Duration The duration of the fax transaction in sec-
onds.

Caller The telephone number, if any, programmed 
into the remote facsimile device.

Dcl Time The outbound fax Job ID number assigned 
by Print Services.

Doc ID The IDMIS document ID that is assigned 
when the document is committed to optical 
disk. For additional explanation, see “Images 
and Documents” on page 23. 

User ID The name that the user entered to log on to 
the IDMIS server.
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The following illustration shows a typical FAXJRN.DAT journal window 
that displays a normal view of outbound transactions.
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If you need to adjust the width of a field to view the information in it, 
move the pointer to the edge of the field you want to widen or narrow 
(the pointer changes to ). In the following example, the pointer is 
between the Phone and Recipient. Drag the field to the left to narrow it 
or to the right to widen it.
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Viewing Errors in the Journal Window

The following lists the errors that can appear in the Error column and 
describes their meanings.

Error Meaning

Line Error A line error, such as excessive noise, disrupted the 
fax transaction.

Local Error An error occurred with the Panagon Fax system.

Remote Error An error occurred at the remote facsimile destination.

Incompatible The remote facsimile device is not compatible with the 
Panagon Fax devices.

No Fax There is no facsimile device at the fax number dialed.

Disconnected The fax call disconnected unexpectedly.

No Dial Tone A call was not placed because a dial tone could not be 
detected.

Line Busy The fax number dialed was busy.

Line Dead The telephone line is not operational.

No Answer The remote facsimile device did not answer the call.

Unknown An unknown error occurred.

Migration Error An error caused by corrupt data or missing pages dur-
ing migration of the fax from the Network Fax Server 
to the Fax Manager.
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Closing the Journal Window

To close the journal window, double-click on the “x” in the top-right cor-
ner of the journal window. The journal window becomes an icon within 
the Panagon Fax Manager window. To restore the journal window, dou-
ble-click on the icon.
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Activity Trace Window

Use the Activity Trace command in the Tools menu to trace the 
progress of fax transactions. This window is particularly useful for trou-
bleshooting. Trace data is saved to a file named FaxTRACE.DAT that 
resides in the \fnsw_loc\tmp directory. 

The following illustration shows an Activity Trace window: 

There are two ways to close the Activity Trace window:

• Double-click on the “x” in the top-right corner of the Activity Trace 
window. 

• Select Tools and uncheck the Activity Trace option.

To redisplay the Activity Trace window, select Tools and check the Ac-
tivity Trace option.

Note Displaying the Activity Trace window affects some menus and com-
mands. See “Menu Bar” on page 54 for more information. 
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Switching Between Windows

Although the Panagon Fax Manager can display the FAXJRN.DAT jour-
nal window and Activity Trace window at the same time, only one of 
these windows can be active. 

When a window is not active, its information is updated as an activity 
occurs.  For example, the journal window will still record the current fax 
activity even if the Activity Trace window is the active window. 

To make a window active, click on it or select the window in the Win-
dow menu. Either method highlights the title bar to indicate that the 
window is active.

Status Bar

The status bar at the bottom of the Panagon Fax Manager window 
shows actions currently being performed. You can toggle the status bar 
on or off by using the Status Bar command in the View menu.
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Configuring Panagon Fax Manager

Using the Configuration command in the Tools menu, you can view 
and change Panagon Fax Manager configuration parameters.

When you select Configuration, a dialog box similar to the following 
displays. This is the same dialog box that was completed during the 
Panagon Fax installation. For information on the dialog box parame-
ters, refer to the online help for Panagon Fax Manager.
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Retrying Failed Faxes 

If the Migrate Failed Outbound Fax checkbox is not  checked in the Re-
quest Migration tab of the Panagon Fax Manager Configuration, failed 
faxes:

• Fax Manager will not migrate any failed faxes.

• Will be logged in the Journal. 

• Will display in the Faxes Transmitted ribbon. 

• Will display in the Activity Trace window. 

• Will remain in the Optus outbound folder to be manually sent again 
at a later time. Refer to Optus documentation for instructions to 
manually retry failed faxes.

As in previous releases, if the Migrate Failed Outbound Fax checkbox 
is  checked in the Request Migration tab of the Panagon Fax Manager 
Configuration, failed faxes: 

• Fax Manager migrates all failed faxes (as well as successful ones)

• Will be logged in the Journal.

• Will display in the Faxes Transmitted ribbon.

• Will display in the Activity Trace window. 

• Will be deleted from the Optus queue.

The Request Migration tab is illustrated on the following page.
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Panagon Print Administrator
Using the Panagon Print Administrator application, you can:

• Monitor activity between the server and printer.

• Monitor activity between the IDMIS and print server.

Accessing the Panagon Print Administrator Window

The Panagon Print Administrator icon is located in the FileNET Pa-
nagon Server Applications program group.
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To access the Panagon Print Administrator, double-click on the follow-
ing icon:

A window similar to the following displays:

Panagon Print
Administrator
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Understanding the Panagon Print Administrator Window

The following illustration shows the Panagon Print Administrator win-
dow components.

Menu Bar

The menu bar contains commands for performing various Panagon 
Print Administrator tasks. Some menus and commands are always 
available, while others are available only when the Queue window is 
active. 

Menu Bar

Tool Bar

Queue Fax Window

PSM Listener Window

Status Bar
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The following table describes the available menus and commands. For 
example, the Configuration command in the Tools menu is available 
when either the Queue window or PSM Listener window is active. The 
Download PostScript command in the Tools menu, however, is only 
available when the Queue window is active; it is not available when the 
PSM Listener window is active. 

Note To make a window active, click on it or select the window’s name from 
the Window menu. 

Menu Command Description

File Open Opens a file.

Close Closes a file.

Save Saves a file.

Save As Saves a file in a new directory or under a 
new name.

Clear Clears the currently active window.

Exit Exits the Panagon Print Administrator 
window.
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Options Verbose Mode Provides complete information relevant 
to the currently active window.

Time Stamp Shows the date and time of each oc-
currence in a window.

Logging Saves all information in the currently 
active window to a disk file. 

Retain Files Saves printer-ready files for trouble-
shooting. (Only available when Queue 
window is active.)

View Toolbar Displays or hides the toolbar.

Status Bar Displays or hides the status bar.

Error Log Displays a log of fax errors.

Statistics Displays fax statistics. 

Tools Configuration Displays and changes the Panagon 
Print Administrator configuration pa-
rameters.

Download PS files Downloads PostScript files to the 
printer/fax queue. (Only available when 
Queue window is active.)

Window Arrange the windows on your desktop.

Help Displays Panagon Print Administrator 
online help.
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Toolbar

The Toolbar appears below the menu bar. The toolbar provides a fast 
way of performing tasks. The following illustration describes the tools in 
the toolbar.

 

You can toggle the tool bar on or off by using the Tool Bar command in 
the View menu.

PSM Listener Window

The Print Services Manager (PSM) Listener window automatically dis-
plays in the Panagon Print Administrator window. This window displays 
the activity between the IDMIS and the print server.

The following illustration shows an example of a PSM Listener window. 

Open a file

Save a file

About  Panagon Print Administrator Window   

Run configuration
tool
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With this window displayed, you can use the following commands in 
the Options menu to perform the corresponding tasks:

Verbose Mode Describes each action between the IDMIS and the 
print server, as shown in the previous illustration.

Time Stamp Displays the date and time of each line in the PSM 
Listener window.

Logging Saves the PSM Listener information to a file on the 
hard drive.

To close this window, double-click on the “x”  in the top-right corner. If 
another fax (print) job is being processed but no other PSM Listener 
windows are open, the print job displays in a new PSM Listener win-
dow; otherwise, no PSM Listener windows display in the Panagon Fax 
Administrator window. To redisplay the PSM Listener window, exit the 
Panagon Print Administrator window and then redisplay it.
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Note Making the PSM Listener window active affects some menus and com-
mands (See “Menu Bar” on page 73 for more information). To make 
another open window in the Panagon Print Administrator window ac-
tive, click on the other window or select its name from the Window 
menu. 
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Queue Fax Window

The Queue Fax window automatically displays in the Panagon Print 
Administrator window. This window displays the activity between the 
third-party fax server and the printer.

The following illustration shows an example of a Queue Fax window. 
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With this window displayed, you can use the following commands in 
the Options menu to perform the following tasks:

Verbose Mode Describes each action between the fax server and the 
printer, as shown in the previous illustration.

Time Stamp Displays the date and time of each line in the Queue 
Fax window.

Logging Saves the Queue Fax information to a file on the hard 
drive.

Retain Files  Saves printer-ready files for troubleshooting.

Note Making the Queue Fax window active affects some menus and com-
mands (See “Menu Bar” on page 73). To make another open window in 
the Panagon Print Administrator window active, click on the other win-
dow or select its name from the Window menu. You cannot close the 
Queue Fax window.
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If you encounter errors when sending faxes, use the Error Log com-
mand in the View menu to display the Error Log window. This Log can 
help you identify errors in your fax transmissions.

The following is an example of an Error Log window. To close, double-
click on the “x” in the top-right corner.To close, double-click on the “x” in 
the top-right corner.

Note Displaying the Error Log window affects some menus and commands. 
To make another open window in the Panagon Print Administrator win-
dow active, click on the other window or select its name from the Win-
dow menu.
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Statistics Window

The Statistics window provides statistics on fax activity that may be 
helpful to you. 

To display the Statistics window, make the Queue window active, then 
select Statistics from the View menu.

This illustration shows an example of a Statistics window.

To close the Statistics window, double-click on the “x” in the top-right 
corner.

Note To make another open window in the Panagon Print Administrator win-
dow active, click on the other window or select its name from the Win-
dow menu.
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Configuring Queues with the Panagon Print Administrator

Using the Configuration command in the Tools menu, you can view 
configuration parameters that apply to a specific queue and general 
parameters that apply to all queues. You can also change these pa-
rameters if your Windows NT user name has edit access to the Pa-
nagon Print configuration.

When you select the Configuration command in the Tools menu of the 
Panagon Print Administrator menu, a dialog box similar to the following 
displays.
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Queues mapped to a Panagon Print 
printer
or Network Fax Server

fax232
fax267
fax309

Currently selected 
IDMIS or IDMIS 
server

Queues not mapped 
to a Panagon Print 
printer or Network 
Fax Server
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Note This is the same dialog box completed during the Panagon Fax instal-
lation. You can also access this dialog from the Panagon Print Configu-
ration icon in the FileNET Panagon Fax Server Applications window. 
For more information on selecting configuration parameters, refer to 
the Panagon Fax Installation Guide and the online help for Panagon 
Print Configuration.

From this dialog box, you can:

• Configure print queues.

• Use the Fonts button to configure fonts and character sets for all 
queues configured on the print server.

• Use the Fonts and Map Fonts buttons to map a Pcode font to a 
PostScript font.

• Use the Options button to specify:

• Primary cache and temporary files directories.

• The maximum number of pages for each FileNET queue.

• The date and time format that displays on a Request Header 
page.

• Verbose mode, checksum, annotation, and margin note and 
highlight parameters.

• A fax user key delimiter.
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Downloading PostScript Information

Use the Download PostScript command in the Tools menu to download 
a PostScript file from the personal computer’s hard disk to the printer 
or fax queue for transmission to a remote facsimile destination.

When you select Download PostScript, a dialog box similar to the fol-
lowing displays. 

You can then select the PostScript file you want to download and click 
OK. If the PostScript file is not at the location shown, you can use the 
controls in the dialog box to change to the drive and directory where 
the file resides, then select the file and click OK. 



2  Managing Outbound Documents

Panagon Print Configuration

July 1998 Panagon Fax User’s Guide 87

Note The Download PostScript command is only available when the Queue 
window is active. See “Menu Bar” on page 73 for more information.

Panagon Print Configuration
Use the Panagon Print Configuration application to view and change 
Panagon Print configuration parameters. 

The Panagon Print Configuration icon is located in the FileNET Pa-
nagon Server Applications window. To access the Panagon Print Con-
figuration dialog box, double-click on the following icon:

Panagon Print
Configuration
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A dialog box similar to the following displays.

 

Note This is the same dialog box that was completed during the Panagon 
Fax installation. You can also access this dialog box from the Panagon 
Print Administrator Tools menu (see page 41). For information on the 
dialog box parameters, refer to the Panagon Fax Installation Guide or 
the online help for Panagon Print Configuration.
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Panagon Print Setup
Use the Panagon Print Setup application to upgrade to a newer re-
lease of Panagon Print software.

Accessing the Panagon Print Setup Window 

The Panagon Print Setup icon is located inside the FileNET Panagon 
Server Applications program group.

To access the Panagon Print Setup dialog box, double-click on the fol-
lowing icon:

Panagon Print
Setup
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A dialog box similar to the following displays.

When this dialog box appears:

1 Insert the diskette or CD containing the new version of Panagon Print 
in a drive.

2 Change the drive letter in the dialog box (if necessary) to reflect the 
drive where you inserted the disk or CD.

3 Click on Continue.

4 Follow the screen prompts to install the new version of Panagon Print. 
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3
3 Managing Inbound Documents

This chapter describes how to initiate the Panagon Fax software and 
the applications contained in the Fax Entry program group. These ap-
plications are used to manage inbound fax documents.

Starting Panagon Fax Software
When you install Panagon Fax software, you can have the FileNET Pa-
nagon Fax Entry icon located in the FileNET Panagon Capture pro-
gram group, moved to the Startup program group.

You can also move the Panagon Fax Manager program icon from the 
FileNET Panagon Server Applications program group to the Startup 
program group. Startup is located in the Programs group in the Start 
taskbar. Doing so starts Panagon Fax Entry and the Panagon Fax 
Manager automatically each time you start Windows NT.

For more information, refer to your Windows NT documentation.
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To open the FileNET Panagon Capture group, double-click the Pa-
nagon Capture icon.

The FileNET Panagon Capture group contains the FileNET Panagon 
Fax Entry programs. The icons in the FileNET Panagon Capture group 
are shown as follows. These icons contain the applications that you will 
use to manage inbound fax documents.

For Inbound Fax

For Outbound Fax
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The following sections describe these applications.

Panagon Fax Entry
Panagon Fax Entry is used to process inbound documents for delivery 
to the IDMIS and to the Local or BES cache and/or back them up to a 
local or network drive.

Use Panagon Fax Entry to:

• View inbound document status

• View and change the FaxEntry configuration parameters (if permit-
ted) 

• Trace inbound fax activities 
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Accessing the Panagon Fax Entry Window

To access the Panagon Fax Entry window, double-click on the FileNET 
Panagon Fax Entry icon located in the FileNET Panagon Capture pro-
gram group:

The following window indicates that Fax Entry started successfully.
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Understanding the Panagon Fax Entry Window

The following illustration shows Panagon Fax Entry window compo-
nents. 

Note In this screen, all Migration ribbons are displayed. You can toggle each 
ribbon on or off using the View menu.  The ribbons display when en-
abled in the Configuration menu and do not display when disabled.

 

 

Status bar

Migration Ribbon

Menu Bar

Activity Trace Window

Journal Window
 

Clock
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Menu Bar

The menu bar contains commands for performing various Panagon 
Fax Entry tasks. 

The following describes the available menus and commands.

Menu Command Description

File Migrate Journal Now Manually migrates the journal to 
optical disk. Overrides the Migra-
tion Interval parameter configured 
in the Journal Migration Configura-
tion dialog box. 

Convert Journal Converts the journal log to a binary 
file to an ASCII text file. 

Exit Exits the Panagon Fax Entry win-
dow.

View Journal Migration Displays or hides the journal migra-
tion ribbon if Journal Migration is 
enabled in the Configuration pull-
down menu.

Inbound Migration Displays or hides the inbound mi-
gration ribbon if Inbound Migration 
is enabled in the Configuration pull-
down menu.

File Migration Displays or hides the file migration 
ribbon if File Migration is enabled in 
the Configuration pull-down menu.
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Journal Show All Entries Displays all migrated inbound, file, 
and other fax entries in the Journal 
Window.

Clear All Entries Clears all fax entries from the Jour-
nal Window.

Migrated Inbound Entries Displays only inbound faxes that 
have been processed in the Jour-
nal Window.

Migrated File Entries Displays all files in the Journal Win-
dow that have been processed.

Migrated Journal Entries Displays all Journal Logs that have 
been processed. 

Refresh Screen Enables the user to manually re-
fresh the screen; the journal screen 
continues to be updated automati-
cally.
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Menu Command Description

Configuration Journal Migration Displays and changes journal 
migration configuration parame-
ters.

Inbound Migration Displays and changes inbound 
migration configuration param-
eters.

File Migration Displays and changes file mi-
gration configuration parame-
ters.

System Displays and changes system 
configuration parameters.

Trace Displays and changes activity 
trace configuration parameters.

Tools Activity Trace Displays or hides the Activity 
Trace Window.

Window Arranges the windows on your 
desktop and displays which 
windows are active.

Help Displays online help.
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Journal Migration

Journal Migration is configured in the Journal Migration Configuration 
dialog box, where parameters are set during the installation of Pa-
nagon Fax Entry. Most parameters can be changed later. Refer to the 
Panagon Fax Installation Guide and the Panagon Fax Online Help for 
details.

You can set the number of journal records that can accumulate in the 
Journal Log file in the Max Journal Record Count parameter. Journal 
log entries are circular in nature. According to the maximum number of 
entries set, the last entry will be deleted when capacity is reached and 
the next entry is input. 

Additionally, if the Enable Journal Migration option is enabled, the Jour-
nal Log will be committed to the IDMIS and moved to Local or BES 
cache, or backed up to the Backup Directory field specification when 
the Max Journal Record Count parameter reaches this value, even if 
the Migration Interval parameter has not expired. At that time, the 
screen is cleared and ribbon counters are reset to zero.The default is 
500 entries, but may be set from 100 to 5000 entries.

Specify the number of lines per page on each journal file in the Lines 
Per Page parameter. The default is 40 lines, but may be set from 10 
through 200 lines.

You can specify the length of time that must elapse after the journal file 
has been processed, before Fax Entry looks for the next journal file. 
The default value is 60 seconds, but can be set within the range of 10 - 
3600 seconds in the Migration Interval parameter.

The journal file to be processed is contained in the default folder  
named \FaxEntry\Journal\FEJrn.log. You can assign a new folder in 
the Journal File Name parameter.
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You can move your files to Local or BES cache and commit them for 
storage on the IDMIS without backing them up, or back them up to a lo-
cal or network drive, or do both. Specify this setting in the Migration 
Option parameter. If you are backing your files up, or backing up and 
committing to the IDMIS, the default backup folder is 
\FaxEntry\Backup. This parameter is specified in the Backup Directory 
parameter. 
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Journal Migration Ribbon

The Panagon Fax Entry window provides a Journal Migration Ribbon 
that summarizes journal entry information. Migration takes place when 
one of the following occurs:

• When a preset time interval lapses

• When a preset number of fax requests accumulate

Information in the Journal Migration Ribbon Information includes:

Journal Migration The total number of journals processed

Uncommitted Batch(es ) The number of journals that are not com-
mitted and reside in the BES Repository. 

Committed Document(s) The number of journals committed to opti-
cal disk as documents

To display the journal migration ribbon, select Journal Migration from 
the View menu. The Journal Migration menu option will be grayed (not 
available) unless Journal Migration is enabled in the Configuration 
menu and in the View menu.

The following illustration shows a typical Journal Migration Ribbon.
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Inbound Migration

Inbound Migration is configured in the Inbound Migration Configuration 
dialog box, where parameters are set during the installation of Pa-
nagon Fax Entry. Most parameters can be changed later. Refer to the 
Panagon Fax Installation Guide and the Panagon Fax Online Help for 
details.

Panagon Fax Entry migrates files in groups. You can specify the length 
of time that must elapse after a group of files have been processed, 
before Fax Entry looks for additional files. The default value is 60 sec-
onds, but can be set within the range of 10 - 3600 seconds in the Mi-
gration Interval parameter.

During each migration period, Panagon Fax Entry, by default, pro-
cesses 10 files in a group. You may want to limit the number of files to 
avoid network congestion. You can change the default to a range from 
1 - 20 in the Requests per Migration parameter.

You can commit your files for storage on the IDMIS and move them to 
Local or BES cache without backing them up, or back them up to a lo-
cal or network drive, or do both. Specify this setting in the Migration 
Option parameter. If you are backing your files up, or backing up and 
committing to the IDMIS, the default backup folder is 
\FaxEntry\Backup. This parameter is specified in the Backup Directory 
parameter. 

Failed inbound data, such as data that did not complete transmission, 
are stored in the default error folder \FaxEntry\Error. You can change 
the error folder by specifying a new folder in the Error Directory param-
eter. 
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Inbound Migration Ribbon

The Panagon Fax Entry window provides an Inbound Migration Ribbon 
that shows summary information of inbound entries. Information in-
cludes: 

• The total number of inbound faxes processed.

• The number of inbound fax requests processed as uncommitted 
batches (multiple documents) and left in local or BES repositories.

• The number of inbound fax requests migrated to the IDMIS optical 
disk.

The number of uncommitted batches and committed documents equal 
the total number of inbound faxes received.

To display the inbound migration ribbon, select Inbound Migration from 
the View menu. 

Note The Inbound Migration menu option will be grayed (not available) un-
less Inbound Migration is enabled in the Configuration menu and the 
View menu. 

The following illustration shows a typical Inbound Migration Ribbon.

Note The FileNET Scanning status box will display briefly as Panagon Fax 
processes inbound faxes. 
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File Migration

File Migration is configured in the File Migration Configuration dialog 
box, where parameters are set during the installation of Panagon Fax 
Entry. Most parameters can be changed later. Refer to the Panagon 
Fax Installation Guide and the Panagon Fax Online Help for details.

Panagon Fax Entry migrates files in groups. You can specify the length 
of time that must elapse after a group of files have been processed, 
before Fax Entry looks for additional files. The default value is 60 sec-
onds, but can be set within the range of 10 - 3600 seconds in the File 
Migration Interval parameter.

During each migration period, Panagon Fax Entry, by default, pro-
cesses 10 files in a group. You may want to limit the number of files to 
avoid network congestion. You can change the default to a range from 
1 - 20 in the Files per Migration parameter.

Files to be processed are contained in the default folder \FaxEntry\File. 
Any file in this folder will be processed and deleted after processing. 
You can assign a new folder in the File Migration Path parameter.

You can commit your files for storage on the IDMIS and move them to 
Local or BES cache without backing them up, or back them up to a lo-
cal or network drive, or do both. Specify this setting in the Migration 
Option parameter. If you are backing your files up, or backing up and 
committing to the IDMIS, the default backup folder is 
\FaxEntry\Backup. This parameter is specified in the Backup Directory 
parameter. 
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File Migration Ribbon

The Panagon Fax Entry window provides a File Migration Ribbon that 
shows summary information of file entries. Information includes:

• The total number of files processed.

• The number of file requests migrated as Uncommitted Batches 
(multiple documents).

• The number of files committed to the IDMIS optical disk.

The number of uncommitted batches and committed documents equal 
the total number of file faxes received.

To display the file migration ribbon, select File Migration from the View 
menu. 

Note The File Migration menu option will be grayed (not available) unless 
File Migration is enabled in the Configuration menu and in the View 
menu. 

The following illustration shows a typical File Migration Ribbon.
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Journal Window 

By default, the Journal Window automatically displays in the Panagon 
Fax Entry window. The Journal Window monitors all migrated inbound, 
file, and other fax entries. 

Journal log entries are circular in nature. According to the maximum 
number of entries set, the last entry will be deleted when capacity is 
reached and the next entry is input. You can specify the maximum 
number of entries by setting the Max Journal Record Count parameter 
in the Journal Migration Configuration dialog box. The entries are se-
quentially and chronologically ordered.

The default is 500 entries. To change the default, enter a new limit. The 
range is 100 to 5000 entries. 

Changing Journal Window View

Enabling one or more options under the View pull-down menu will dis-
play all or selected entries in the Journal Window:

Show All Entries Shows all inbound faxes, files, and jour-
nal entries. 

Clear All Entries Clears the journal window of all entries. 
A dialog box also asks if you want to 
clear the journal log. If you answer yes, 
the journal log will be cleared and the in-
formation it contains will be lost.
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Migrated Inbound Entries Shows all inbound faxes that Panagon 
Fax Entry has attempted to commit to 
the IDMIS or back up. Define the method 
of processing faxes on the Inbound Mi-
gration Configuration screen.

Migrated File Entries Shows all files that Panagon Fax Entry 
has attempted to commit to the IDMIS or 
back up. Define the method of process-
ing files on the File Migration Configura-
tion dialog box.

Migrated Journal Entries Shows all journal log entries that Pa-
nagon Fax Entry has attempted to com-
mit to the IDMIS or back up. Define the 
method of processing journal files on the 
Journal Migration Configuration screen.

Refresh Journal Entries Refreshes the screen; the journal screen 
continues to be updated automatically.

For additional information, refer to the Panagon Fax Online Help.
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The following illustration shows a typical Journal Window. 

Tip The contents in the Journal Window are updated according to the 
AutoSave Interval value you entered during the Panagon Fax configu-
ration. The number of entries displayed in the Journal Window is de-
fined in the Max Journal Record Count field of the Journal Migration 
Configuration dialog box. Using this field, you can display from 100 to 
5,000 entries in the Journal Window. 
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Initially, the number of entries shown in the Journal Window is based 
on the value you entered in the Max Journal Record Count field when 
you configured Panagon Fax. To change this value, select Journal Mi-
gration from the Configuration menu to display the Journal Migration 
Configuration dialog box. For more information, refer to the Panagon 
Fax online help.

Journal Log Files

Use the Journal Migration Configuration dialog box to automatically 
process journal log files that reside in the directory specified in the 
Journal File Name field.The default journal log file name is 
\FaxEntry\Journal\FEJrn.log. 

The Journal file contains the disposition of incoming data and records 
one entry for each piece of data output.
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Journal Entry Format

Entries in the journal log use the following format:

type mm/dd/yyyy hh:mm:ss <CallerID><ch(annel)>
<DID/DTMF> <pages><document/batch ID> <status>

Type Type can be RECV (migrated inbound fax), LOG (mi-
grated journal log entries) or FILE (migrated file en-
tries).

mm/dd/yyyy Represents the date that the request was migrated.

hh:mm:ss Represents the time the request was migrated. 

Caller ID Indicates the Customer Subscriber Identification num-
ber, i.e., the telephone number of the sending device.

Caller ID (ANI) functionality will be officially qualified at 
a later date. Until it is officially qualified, Caller ID will be 
classified as a configurable feature and will not be sup-
ported. Refer to the following location on FileNET’s Web 
site for official qualification support notification:

http://www.css.filenet.com/documentation

Ch(annel) Represents the channel number or fax device port num-
ber that the call came in on.

http://www.css.filenet.com/documentation
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DID/DTMF If your telephone service supports DID (Direct Inward 
Dial), the Network Fax Server can use from 1 to 15 digits of 
the called phone number to route a fax to a user. DID can 
also be used for indexing information.

If your telephone service supports DTMF (Dual Tone 
Multiple Frequency), the caller can enter a configurable 
number of digits (usually a four-digit extension).  The 
Network Fax Server will use the data to route the fax to 
its destination, route it to a document class, or use the 
data for indexing information.

Page Indicates the number of pages in the migrated request.

Doc/Batch ID Represents the IDMIS-assigned document or batch 
identification number. If a committal request exists, a 
document ID is displayed. If there was no commit re-
quest, the Batch name displays.

Status Indicates migration status. States include Commit, In-
dex, Batch, or Error.

Commit Batch was successfully committed. 

Index Batch is indexed, but not committed.

Batch Batch is assembled but not indexed. 

Error An error occurred during processing, possibly 
due to invalid automatic indexing values. The 
error status also displays if an error occurred 
at any other point during processing.
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Converting the Journal Log file to ASCII

To convert your Journal Log file from a binary file to an ASCII text file, 
use one of the following methods:

• Select the option Convert Journal in the File pull-down menu. 
Specify the destination location for the log files in the Backup Direc-
tory parameter in the Journal Migration Configuration dialog box.

• Select the Journal Migration Configuration dialog box.

Specify the Backup Directory parameter to designate where you 
want both the binary and the ASCII text Journal Logs to be placed.

Set the Migration Option parameter to Backup or Backup and Com-
mit.
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Activity Trace Window 

The Activity Trace Window is used to trace the progress of fax transac-
tions and is defined in the Trace Configuration dialog box. If you select 
the Detail Level parameter, you can determine what type of activity to 
trace as well as how much detail to record:

Normal Trace Records significant errors

Detailed Trace Records significant errors and related informa-
tion

Very Detailed Trace Records significant errors, journal entry informa-
tion, with additional steps and the status of 
each.

This feature is particularly useful for troubleshooting purposes.

You can specify the maximum number of entries that can accumulate 
in the Activity Trace window in the Trace Window Max Entries parame-
ter in the Trace Configuration dialog box. When the maximum is 
reached, original entries are overwritten by new entries in the window. 
Note that this parameter does not affect activity trace entries written to 
the Activity Trace file. The default is 200 entries. The range is 100 
through 999 entries.

If you have checked the Trace File Enabled parameter in the Trace 
Configuration dialog box, fax transactions are saved in the file specified 
in the Trace File Name parameter. The default name is 
\FaxEntry\Journal\FETrace.log. You can enter a different file name and/
or path. 
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Note Trace data will accumulate in this file until you disable this function. 
Therefore, you must periodically delete the file or archive it to prevent it 
from becoming too large. 

Refer to the Panagon Fax Entry Online Help for field definitions.

To view this window, select the Activity Trace command from the Tools 
menu. This command is used to toggle the Activity Trace Window on or 
off. 

The following illustration shows an active Activity Trace Window.

 

Status MessageDate Time
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Switching Between Windows

Although the Panagon Fax Entry window can display the Journal Win-
dow and Activity Trace Window at the same time, only one of these 
windows can be active. Information in both the active and inactive win-
dow is updated as an activity occurs. 

To make a window active, either click on it or select it in the Window 
menu. Either method highlights the title bar in the active window.

Other common window commands accessed from the Windows menu 
include: Cascade, Tile Vertically, Tile Horizontally, and Arrange Icons.

Status Bar 

The status bar at the bottom of the Panagon Fax Entry shows actions 
currently being performed.
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Clock 

A rotating clock is on the left of the status bar, providing a visual indica-
tion that Panagon Fax Entry is operating. This clock is especially con-
venient when inbound fax activity is slow, since there may be no other 
visual indication that the Panagon Fax Entry is operating.

Note If the clock is not rotating in the Panagon Fax Entry window, or if the 

logon icon ( ) is not displayed on your Windows desktop, Panagon 
Fax Entry is no longer communicating with the IDMIS. If either of these 
situations occur, exit and restart Panagon Fax (it is not necessary to 
exit Windows NT).

Configuring Panagon Fax Entry

Use the commands in the Panagon Fax Entry Configuration menu to 
view and change parameters on the following tabs: 

• Journal migration configuration parameters

• Inbound migration configuration parameters

• File migration configuration parameters

• System configuration parameters

• Activity Trace configuration parameters

Normally these parameters are set during the installation. While the 
settings can be changed later, they usually remain as installed. Note 
that a few parameters are exceptions and will normally be reset by the 
user at a later time. These parameters are described as follows. 
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Enable Idle Time Period

Use this feature to backup IDMIS without shutting the Fax Entry ap-
plication down. You can specify the Enable Idle Time Period option 
on the System configuration tab in the Panagon Fax Entry Configu-
ration and render the Fax Entry application idle.   

Enable Idle Time Period allows you to back up the IDMIS during 
the time Fax Entry is inactive, without shutting the Fax Entry appli-
cation down. The Enable Idle Time Period option uses military time 
and can be set within a 48-hour range, during installation or later 
during use. 

For example, you can enter the time period, 22:00 to 30:00, render-
ing the Fax Entry application inactive from 10:00 P.M. on day 1 to 
6:00 A.M. on day 2. At 30:00, Fax Entry will become active and 
again migrate inbound faxes to the IDMIS. The start time must be 
less than 24:00, that is, within day 1.

This option defines a time period when the Fax Entry application is 
idle. When the idle period ends, the application again begins to mi-
grate inbound faxes to the IDMIS. 

To configure this feature, refer to the Panagon Fax Installation 
Guide.

Display Important Messages

In the System Configuration dialog box, if you check the field, Display 
Important Messages in Popup Boxes, important messages, derived 
from the Activity Trace Window, are displayed in a popup, processing is 
halted, and a user response is required to continue processing.

Do not use for unattended processing.
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Storing Inbound Failed Faxes

You can specify an error directory in which to store your failed inbound 
faxes. For example, a failed fax may be one that did not complete 
transmission. 

The default is \FaxEntry\Error. Specify your error directory in the Error 
Directory field on the Inbound Migration Configuration dialog box. To 
change the default, enter a new directory or select the Browse button.

For information on configuration parameters, refer to the Panagon Fax 
Online Help.

Document Processing

Document Processing is represented on both the File Configuration 
and Inbound Configuration dialog boxes. 

Document Processing includes two checkboxes:

• Run DocProcessing Before Event Activator

• Run DocProcessing After Assembly

These options are enabled only if DocProcessing is installed. If not in-
stalled, the options are disabled. If DocProcessing is installed, neither, 
either, or both of the options can be checked.
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Run DocProcessing Before Event Activator

If the DocProcessing Before Event Activator checkbox is checked, 
DocProcessing is run after Fax or File Import and before the Event Ac-
tivator. Use this to clean up images and for bar/patch code detection. 
DocProcessing can set attributes that are used by the Event Activator 
to decide where to make batch and document divisions.

For example, DocProcessing may detect a patch code on a page that 
indicates a certain document type. It would then set an attribute, indi-
cating that the patch code was found. The Event Activator would note 
the patch code and, based on its rules, mark the page as start-of-
batch. Assembly would then move the page(s) into a new batch.

Run DocProcessing After Assembly

If the DocProcessing After Assembly checkbox is checked, DocPro-
cessing is run after Assembly, even if Indexing and Committal will not 
be run. Use this if the required processing is to be applied only to a 
certain document type.

For example, Assembly (with the help of the Event Activator and possi-
bly DocProcessing) may move a particular document type into a sepa-
rate batch. Assembly can assign a new settings collection to the batch. 
Generally, this option is useful when Assembly separates document 
types into different batches and assigns a settings collection to each.
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4
4Problem Reporting

If you have a problem you cannot resolve, remote support is available 
as part of maintenance provided to registered sites. To ensure quick 
resolution of your problem, be prepared to provide the information or 
answer the questions in the following form. After initiating a service call 
through the customer response center, you may be asked to fax the in-
formation.
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Fax Server Problem Report Form

Customer Information:

Company name: ________________________________ Date: ________________________

Site ID: ____________________ Your name: ______________________________________

Phone: ____________________

Problem Description:

Describe the problem:_________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________

_____________________________________________________________________________
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Does the problem occur when only the Fax Server is running? Yes � No �

Does the problem occur using original configuration files? Yes � No �

Can the problem be reproduced?
Frequency of problem (how often): _________________________________

Impact of problem:                      Critical �                   Serious �                    Annoyance � 

Is there a workaround?
If yes, describe the workaround: _____________________________________________

__________________________________________________________________________

Describe the state of the Fax Server screen:____________________________________

__________________________________________________________________________

Error messages displayed on the Fax Server:____________________________________

__________________________________________________________________________

Error message on FileNET IDMIS server:__________________________________________

__________________________________________________________________________

Errors logged in FileNET IDMIS server error logs:___________________________________

__________________________________________________________________________

_____________________
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Hardware:

System:

Manufacturer:_________________________________________

Model:_________________________________________________

Network:

Processor used: �  Pentium �  Other:_____________

Processor speed: ________________________  MHz

Additional memory (past 1 MB): _________________________________________    _________

Network card � Ethernet � Token Ring

Model:

If Other, describe: _________________________________________________________________

Settings for IRQ, I/O port address, shared memory, and DMA channel, if applicable:

__________________________________________________________________
________
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Fax Board: 

Other Services:

Board # ___________ Board Type � CP � CP100

� CPi � CP4/LSI

Board # ___________ Board Type � CP � CPi � CPXPi

� CPD � CP100 � CP120

� CP4/T1 � CP4/LSI

Board # ___________ Board Type � CP � CPi � CPXPi

� CPD � CP100 � CP120

� CP4/T1 � CP4/LSI

Board # ___________ Board Type � CP � CPi � CPXPi

� CPD � CP100 � CP120

� CP4/T1 � CP4/LSI

Board # ___________ Board Type � CP � CPi � CPXPi

� CPD � CP100 � CP120

� CP4/T1 � CP4/LSI

Are any third-party cards installed? If so, please list them:
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Software:

Panagon Fax Release: ____________   FileNET IDMIS System Release: _________________

Optus FACSys Release: ________________

Windows NT Release (4.0 or later): ________________

Please specify any other software installed and running concurrently with Panagon  Business 
System software:

_______________________________________________________________________

_______________________________________________________________________

_______________________________________________________________________

__________________________________________________________________________

Additional Information For a Specific Problem
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Be prepared to send copies of the files listed in the following table. 

If You Have a 
Problem with... Send Copies of These Files...

Fax server installation • C:\FAXINST.LOG

Transmitting a particular 
image file to a remote site

• The image file

• The actual faxed page (if possi-
ble)

• Verbose log

• All of these files:
 \FNSW_LOC\TMP\*.2PS

The fax server hanging • The IDMIS system log file

Adding an on-image note • The actual faxed page (if possi-
ble)

• All files related to the trouble re-
quest in the C:\FNSW_LOC\MI-
GRATE directory

Document committal • Activity trace file:
x:\FaxEntry\Journal\FETrace.log

• Fax Manager Journal Log file

• Panagon Fax Entry Journal Log 
file
x:FaxEntry\Journal\FEJrn.log
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